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OVERVIEW

SDG514 Resistive (10K Potentiometer)
Variable Speed Input

The SDG500 Series (Smart Digital Governor) is designed to regulate engine speed
on diesel and gas/gasoline reciprocating engines. The SDG500 Series is a suitable
replacement for any mechanical system that needs more flexibility, precision or
control in governing speed.

The SDG500 Series is a solid state microprocessor based speed control unit that
offers precise (+/- 0.25 %) speed control with fast response to transient load chang-
es in isochronous and droop modes. Designed for high reliability this ruggedly built
unit is hard potted to withstand the harsh engine environment and can be mounted
directly in the engine compartment.

The SDG500 Series is an integral part of a closed loop control. When connected to
an electric actuator and supplied with a magnetic speed sensor signal, the gover-
nor will direct the engine to the desired speed setting. The SDG500 Series (Smart
Digital Governor) is designed for industrial applications ranging from generators and
mechanical drives to pumps and compressors.

*  Fast, Compact Digital Engine Speed Governor

«  Solid-State Microprocessor-Based Device Designed to

«  Control Engine Speed with Precise Response to

*  Transient Load Changes

«  Easy Configuration using GAC SmartVU Software

*  Three Fixed Speeds and One Variable Speed each with Droop Governing
Capability

*  Overspeed Shutdown Protection

*  Speed Ramping from Idle to Operation Speed

«  Starting Fuel Control for Lower Engine Exhaust

«  Emissions

GACs SmartVU software allows you to configure and tune on the fly or save to
download to multiple units.

SDG524 0-5V DC Variable Speed Input

SPECIFICATIONS

PERFORMANCE

Isochronous Operation/Steady State
Stability

Speed Range/Governor
Speed Drift w/ Temp
Idle Adjust

Droop Range

Speed Trim Range

ENVIRONMENTAL
Ambient Operating Temperature Range

Relative Humidity

RELIABILITY
Vibration

Testing

CONFIGURATION PARAMETERS

+0.25% Flywheel Teeth 50 - 250

Range (Gain/Stability multiplier) 1-10

400 - 10 KHz Fixed Speed Settings 0 - MAX RPM

<+ 1%MAX Variable Speed Settings 0 - MAX RPM

Full Range Overspeed Setting 0 - MAX RPM

1-17 % Regulation Starting Fuel Preset 0 - MAX Fuel

+ 5 % of Rated Speed

INPUT/OUTPUT PARAMETERS
Suopl 12 - 24 V DC Battery Systems
-40 to +85°C PPl (6.5V DC to 33V DC
[-40 to +180°F] Polarity Negative Ground (Case Isolated)
Up to 95 %

Ground Power Consumption

Speed Sensor Signal

79 @ 20-100 Hz Actuator Current

100 % Functionally Tested

Load Share/Synchronizer Input

70 mA MAX Continuous plus
actuator current

0.5-120 VRMS
7 A continuous
0-10Vv DC
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INSTALLATION

To mount the SDG to a panel, drill 2 (@.181 / .176 [ 4.6 /4.5mm drill size) holes for mounting screws. Place module in front of the panel
aligning with the pre-drilled holes. Secure the module in place with two M-4 screws. Locate the SDG Series control a distance from ex-
treme heat, wires or coils. Operating temperature range is from -40 to 85° C [-40 to 180°F].

PHYSICAL DIMENSIONS OF SDG514 and SDG524
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n WIRING

Using the GAC CH1330 cable harness or the EC1330 connector and required wiring, connect to the SDG500 Series speed controller

using the following wiring diagrams and wiring pin tables. An additional RS-232 to USB connector is required to work with the SmartVU
configuration application.

SDG514 WIRING DIAGRAM

16 AWG

16 AWG
15 AMP
FUSE
SPEED
= ¥ SELECT —— RS232-Tx
12/24 VDC 20AWG
RS232-Rx
- SPEED SELECT SETTINGS
e > [ ]
23 4 Pin 2 Pin 3 Speed Select
1211 10 9 8 7
??P?7°%S" No Connect No Connect Variable Speed*
Battery - No Connect Fixed Speed 1
No Connect | Battery - Fixed Speed 2
Battery - Battery - Fixed Speed 3
*A 10K Variable Speed Potentiometer needs to be connected to
activate for an SDG514
ACTUATOR —— L ACTUATOR
HIGH 16 AWG LOW 16 AWG
20 AWG
MAGNETIC ;
PICK-UP AANAA VARIABLE SPEED
10K
POT
20 AWG TWISTED SHIELDED PAIR
NC
20 AWG LSM/SYC 0 - 10 VDC IN
5VDC NOMINAL
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SDG514 WIRING DIAGRAM (CONTINUED)

DEUTSCH CONNECTOR SDG514

PIN # DESCRIPTION COMMENT RECOMMENDED WIRING
1 +12 /24 VV DC Input Power Supplies power. 16 AWG
2 Speed Select 2 See Speed Select Settings table 20 AWG
3 Speed Select 1 See Speed Select Settings table 20 AWG
4 RS232 RS232
5 Input Power Ground Ground for the 12/ 24 V DC Input Power 16 AWG
6 RS232 RS232
7 Actuator Low Output to Actuator 16 AWG
8 POT Input Input for 10K Potentiometer for Variable Speed Control 20 AWG
9 No Connection No Connection NC
10 0-10 V DC Input Input for communication of LSM/SYC 20 AWG
11 MPU + MPU speed signal input Shielded/Twisted Pair
12 Actuator High Output to Actuator 16 AWG
SDG524 WIRING DIAGRAM
16 AWG -
16 AWG ~ i
15 AMP
FUSE
SPEED
- - SELECT RS232-Tx
1224 VDC 20 AWG
RS232 DB9 SDG PLUG
PIN PIN
2 4
I 1T - 5 5
( ? I! - 1I 3 6
[ 121 10 9 8 7
[ N B BeON  ]
S
ACTUATOR —
HIGH 18 AWG
20AWG
MAGNETIC A
PICK-UP
20 AWG TWISTED SHIELDED PAIR
SOANG LSMISYC 0-10VDC IN

DEUTSCH CONNECTOR SDG524

PIN # DESCRIPTION COMMENT RECOMMENDED WIRING
1 +12 /24 V DC Input Power Supplies power. 16 AWG

2 Speed Select 2 See Speed Select Settings table 20 AWG

3 Speed Select 1 See Speed Select Settings table 20 AWG

4 RS232 RS232

5 Input Power Ground Ground for the 12 / 24 VDC Input Power 16 AWG

6 RS232 RS232

7 Actuator Low Output to Actuator 16 AWG

8 Variable Speed Input 10-5 V DC Signal 20 AWG

9 No Connection No Connection NC

10 0-10 V DC Input Input for communication of AUX 20 AWG

11 MPU + MPU speed signal input Shielded/Twisted Pair
12 Actuator High Output to Actuator 16 AWG
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INSTALLING AND USING SMARTVU TO CONFIGURE SDG500 SERIES

The SDG 500 Series are configured using the free PC application SmartVU, available on the GAC web site. SDG uses V2.1.3 of the

SmartVU application available for download from GOVERNORS-AMERICA.com and look for the software download link for the SDG500
Series.

INSTALLING SMARTVU FOR SDG500 SERIES SOFTWARE
The configuration software for the SDG does not affect the registry rights of your operating system and therefore is easy to install.
1. Click the link for the software download. You will be taken to a dropbox download area. Click Download.

2. Select the folder you want to install the software into and save the SmartVU SEC 2.1.3 zipped file to that location.
3. Double click the zip folder and open the file folder.
4. Double click the SETUP.exe file. Follow the installation instructions.
CONNECTING THE SDG TO THE PC FOR CONFIGURATION
1. Connect the CH1330 cable harness or use the EC1330 to build a harness to connect the SDG and the engine’s cable harness.
2. Connect your PC and the CH1330 using an USB/Serial Adapter.
SMARTVU CONNECTION SETTINGS B
1. Double click on GAc_SDG51X.exe file to start the SmartVU™ Utility. Communications S Cunent Date
2. If the software does not indicate connected on the bottom left section commpor | =] | | [0 W o hmomD o
of the screen, select configure from the drop down menu and choose BaucRats 13200 +] | | M0 Mo e e T o
. . ata Bits - S0G 510/511
communications. . DIP:H:V [eme =] SO 51401 AT PR
3. Select the number of the Comm Port used from the drop down list sopo Shs1en 7 e 1 02
box. e = 12z 3 4 5 6 7
4. Select SDG 514-01 at initial setup, or using the Configure - Prefer- ”‘;‘I"’“’N P — D Tody: 22/
ences drop-down menu. SDG514-01 is also used for the SDG524. If e e ASC”' —— ‘;’m:"
you have an alternate - number (-02 or -03) see your GAC represen- -
tatIVe for further |nformat|on — ii‘\l%lj Please wait while Windows configures Microsoft Office Visio 2010
5. Click OK. Windows will configure the view screen and then display
the main screen. _ e
6. You can set up a password at this time, but ensure you do not lose

track of it.

CONFIGURING WITH SMARTVU

Parameter settings can be made while attached to the engine, or made in OFFLINE mode as described later in this section. These con-
figurations settings can be stored and used on other engines as needed.

REQUIRED CONFIGURATION SETTINGS (C]meewsyps

The following parameter settings are required Fle Edi Confiqure Options
beforce Stakrt_ll_ng the e.nglne: STARTING PARAMETERS SETUP & SAFTEY PARAMETERS
¢ ran ermlnatlon Crank Temmination Fuel Ramp Time Fuel Begin Point Overspeed Teeth
*  Overspeed 750  FPM oz Y} 3600 RPM 120
+ Teeth
. FiXed Speed 1 FIXED SPEED PARAMETERS SPEED PARAMETERS

. 21 [3 - Idle Speed] Ramp Up Actual Speed
. Fixed Speed 2 Speed Droop Speed Droop Speed Droop 55 RAPM/ 397 FPM
o FiXed Speed 3 (lDLE) 3000 RPM 10 % 1500 RPM 20 % 1800 RPM MM % £75  Ha

Ramp Down
*  Speed min VARIABLE SPEED PARAMETERS 66 FPM/s
. P - Gain Droop Speed min  Speed max PDE “l:::.ternpa;l ;‘nax w Speed Request
. |_ Stablllty 15 % 500 RPM FFM 1023 840 1500 RPM
* D - Derivative ENGINE RESPONSE PARAMETERS
GOVERMOR
SAVING SETTINGS Pomm— ) |3 A
. . . Y
To save the settings directly to the engine: | — 2 %
*  Press the Save Data to Device button on the o ,M*/
lower right corner of the SmartVU screen. - .

To save the settings as a configuration file for use D"’"‘,%"'ﬂ_zu
on other engines, select: T —
1. File > Save Config
2. Select a location to save it on the hard drive of 2t _Cornected

your computer
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CONFIGURING WITH SMARTVU (CONTINUED)

SETTING VARIABLE SPEED

For the SDG524:

¢ Make sure the voltage source for variable speed is connected correctly and SmartVU is open.

¢+ While connected to the engine click on the Speed Pot Calibration button.

+ Set the Minimum value to the lowest controlling voltage and the set the RPM min on the screen.

* Click on the Continue button.

+ Set the Maximum value to the highest controlling voltage, and then RPM max on the screen and click the Continue button.

+ Click OK on the popup window to calibrate.

WORKING IN OFFLINE MODE

GAC’s configuration software allows you to work offline to input/ change parameters that you can then save to a file and use to load to

multiple units. To work in this mode:

Enter desired configurations.

pONM=

Changes made in offline mode must be saved before switching to Save mode.

USING SMARTVU DEVICE MONITOR

The device monitor is a visual interface which helps
you monitor key outputs of the control system.

To display the Device Monitor, select Options -
Device Monitor, from the drop-down menu or press
Ctrl+B.

The Speed Monitor screen is an example of the
device monitor screen.

»  The device displays engine speed (rpm) based
upon the measured magnetic pickup frequency
(Hz) and using the Display Speed tab.

*  The device monitor also features many format-
ting options for the graphic interface including
AutoScale time base adjustment, refresh, and
display freezing (stop). Formatting is set up
from the Options tab and includes:

*  Auto Scale
» Trace Colors
*  Trace Width

+ Stop
. Hold at end
. Refresh

*  Scope Chart
*  Actduty cycle

*  Make the time scale smaller by pressing the
zoom in ‘+’ button and larger by pressing the
zoom out “—* button.

»  File> Print Screen prints the current view if
you have a printer attached to your PC.

Select configure from the drop down menu and choose OFFLINE.

Choose Save from the file menu to save to file. Choose a location and a filename to save the parameter settings.
Select the Save OFFLINE to Device button to save the configurations to the SDG.

i

File Edit Configure Options

Droop %S Diroop 1

[0 %2 [0 %

Mmoo | Modbus Timeout

M2 @&
—
A
Freq [Hz)
] 1]
] M2
I
4 3
Time
Time [sec] Bebs
Gpeed) Dizplay
.l 0 Gain W Auta Scale Speed (o]
| 0 Stabiliy Trace Color  |Green
I 0 Derivative SaveDatatoDevice || [~ Siop  Reset| [ %2
Diroop 3 Dither Speed Request C
0 % 0z 0 RAPM " Scope ™ Chat O DC
Communications Stopped
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SMARTVU PARAMETER SETTINGS

ltems in gray are required.

PARAMETER
[REQUIRED]

[Crank Termination]
[Derivative]
Damping

Dither

Droop 1

Droop 2

Droop 3

Droop Variable Speed
[Fixed Speed 1]
[Fixed Speed 2]
[Fixed Speed 3]
Fuel Limit

[Gain]

[Overspeed ]

POT min

POT max

RPM max

[RPM min]

Speed Ramp Down
Speed Ramp Up
Speed Request

[Stability]

Starting Fuel Ramp

Starting Fuel Start Point

[Teeth ]

Variable Speed on SDG514

Variable Speed on SDG524

DESCRIPTION

RPM set point for crank termination. When the engine RPM exceeds the crank termination set point, the SDG
switches from start up cycle to PID loop control. Set parameter higher than the maximum cranking RPM.

PID parameter. Derivative mode is a breaking action to the controller response as the process variable approaches
the set point.

Applies a damping variable to the Gain Function.

Imposes a random vibrating on the actuator drive. Only available on some models.

The percent of compensation which reduces the governor’s reference speed as fuel position or load increases in
reference to Fixed Speed 1.

The percent of compensation which reduces the governor’s reference speed as fuel position or load increases in
reference to Fixed Speed 2.

The percent of compensation which reduces the governor’s reference speed as fuel position or load increases in
reference to Fixed Speed 3.

The percent of compensation which reduces the governor’s reference speed as fuel position or load increases in
reference to Variable Speed.

Desired RPM set point when the speed select input is set to 1.
Desired RPM set point when the speed select input is set to 2.
Desired RPM set point when the speed select input is set to 3.

The percentage limiter set point on the fuel demands that prevents the over fueling after the engine has started.

PID parameter. Proportional mode responds to a change in the process variable proportional to the current
measured error value.

RPM Set Point for an Engine Shutdown Signal to the actuator.
Max RPM value from the SDG analog to digital converter. For use with SDG514.
Min RPM value from the SDG analog to digital converter. For use with SDG514.

Maximum RPM set point for Variable speed.
Minimum RPM set point for Variable speed

The % percent set point to decrease engine speed per second when changing speeds.
The % percent set point to increase engine speed per second when changing speeds.
Desired speed of engine at the current state.

PID parameter. In integral mode, the controller output is proportional to the amount and duration of the error signal.

Gradually increases the amount of fuel after the engine finishes cranking, which eliminates most unnecessary smoke.
The higher the setting the quicker the engine comes to speed. The percent to increase the fuel flow per second until
the engine reaches 100% or the governor takes control.

Determines how much fuel to begin with before fuel ramping engages. The minimum fuel required for starting the
engine. Retards black smoke. The starting position of the actuator at engine start.

Number or teeth on the flywheel. Used to calculate speed settings and values.

Using a potentiometer to set Variable Speed , in SmartVU, click on the Speed Pot Calibration button. Set the
Minimum position on the potentiometer and then set the RPM min on the screen. Click on the Continue button. Set
the Maximum position on the potentiometer and then RPM max on the screen click on the Continue button. Click OK
on the popup window to calibrate.

Using a voltage source as noted in the wiring diagram, using SmartVU, click on the Speed Pot Calibration button.
Set the Minimum value to the lowest controlling voltage and set the RPM min on the screen. Click on the Continue
button. Set the Maximum value to the highest controlling voltage, and then RPM max on the screen click on the
Continue button. Click OK on the popup window to calibrate.
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n TROUBLESHOOTING

SYMPTOM
ENGINE NOT STARTING

ENGINE NOT STARTING

ENGINE STARTS BUT NOT
RUNNING AT PROPER
SPEED

ENGINE NOT RUNNING
AT THE CORRECT VARI-
ABLE SPEED

OVERSPEED DURING
LOAD TRANSIENT

OVERSPEED DURING
SPEED CHANGES

CHECK THE FOLLOWING

1. Check for battery connection, proper polarity, and proper charge.
2. Recheck Flywheel Teeth, Overspeed Setting, Variable and Fixed Speed Settings.

While cranking the engine:

3. Measure the battery voltage while attempting a crank. If the voltage drops below 8 Volts then the battery is not
sufficiently charged.

4.  Check that the actuator voltage is no less than 2 volts below than battery voltage. If the actuator voltage checks
then verify the proper connection of the actuator.

5. Check Crank Termination setting. Typically the Crank Termination should be set to at least 50RPM higher than
the maximum cranking speed of the engine. If possible measure the cranking RPM of the engine. You can try
increasing in T00RPM increments. If engine appears to start but cuts out then the Fuel Limit may be too low. Try
increasing the Fuel Limit to 100% initially to disable the Fuel Limiting. If the engine starts, the Fuel Limit will have
to be reduced from 100% to more optimum level.

6. Verify the Mag Pickup is properly connected. If possible measure the pickup signal while the engine is cranking.
The voltage must be a minimum of 0.5VRMS for proper operation.

7. If possible through the configuration software check the Starting Fuel Limit and the Starting Fuel Start Point. Via
SMARTVU, set the Starting Fuel Start Point to 10% and the Starting Fuel Ramp Time to 0%. This will program
maximum fuel to the engine at the start.

With engine running:

1. Check to see if the Fixed Speed inputs are properly configured. If one or both of the Fixed Speed inputs are not
connected to ground the SDG will operate in variable speed mode.

2. Make sure the correct number if Flywheel Teeth is set using the configuration software.

3. Make sure the proper Fixed Speed is set using the configuration software.

4. Check mag pickup signal.

With engine running:

1. Make sure the Variable Speed Potentiometer is connected properly. Refer to the configuration section for proper
setup. Verify, through the configuration software, that the MIN speed setting is less than the MAX speed setting.

2. Be sure the proper number of Flywheel Teeth are set.

With engine running:
1. Overspeed setting may be too low. Recheck the overspeed setting.
2. The SDG is not tuned properly for the application. Try retuning the SDG.

With engine running:
1. Overspeed setting may be too low. Recheck the Overspeed setting.

2. Speed Ramp setting is set too low. Increase the Speed Ramp setting. This will cause the engine to accelerate more
slowly, reducing overshoot.
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